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1 Web License 
Overview, Set Up 
and Management

The information in this guide is arranged into the following 
main topics:

• Kurzweil 3000 Web License Overview on page 2.

• Web License System Requirements on page 5.

• Installing Web License Client Software on page 6.

• Working with User Accounts and License Allocation on page 7.
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Kurzweil 3000 Web License Overview
Kurzweil 3000 Web License Overview
Licenses for Using Kurzweil 3000 Over the Internet

The Kurzweil 3000 Web License product offers convenient, secure Kurzweil 
3000 license check in/out through the Web.

Unlike Network Edition licenses, the storage and management of which are 
on the local network, Web licenses are stored and managed by Cambium 
Learning and delivered to users over the Internet. 

In addition to placing less of a burden on a school’s technology team, Web 
Licensing allows users to access licenses and run Kurzweil 3000 from any 
computer on which the Kurzweil 3000 Web License Client software is 
installed, and from anywhere on the Internet.

Web License Users

There are three types of users:

• Designated License Coordinator who is set up by Cambium Learning for 
the organization. This user has the ability to create and manage sub-
users and to allot licenses to those sub-users, which can include Student 
users. When viewing user information, this user can see and change all 
of his/her sub-users’ information. When viewing Universal Library 
contents, this user can access all of his/her sub-users’ folders. 

• Site coordinator who could be a teacher, principal, or other school 
authority. Set up by the organization’s license coordinator, this user has 
the ability to create and manage sub-users, including Student users, and 
to allot licenses to those sub-users. When viewing user information, the 
site coordinator/teacher user can see and change all of his/her sub-
users’ information. When viewing Universal Library contents, this user 
can access all of his/her sub-users’ folders. 

• Student users are created and registered by any user who can create 
sub-users. They cannot, however, have sub-users, nor have access 
other users’ folders in the Universal Library except Public ones created 
by their teachers or for the organization. 
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Kurzweil 3000 Web License Overview 
Complemented by Web-Based Universal Library

Included with the Kurzweil 3000 Web License Edition is the Web Universal 
Library, a robust file repository that provides leveled access to files and 
documents.

The Web Universal Library enables districts or schools to widely distribute 
curriculum, and share and reuse material. Any user can upload district-wide 
curriculum and resource files. Teachers are able to post classwork, and 
students can access those files and documents from anywhere on the 
Internet, from any Kurzweil 3000 Web Client computer, at any time.

The Web License Universal Library also includes the Classic Literature 
collection of nearly 2000 public domain electronic text, from literary classics, 
factbooks, and references to religious and historical documents.

Roaming Preferences

Once set, Kurzweil 3000 personal preferences, such as reading voice and 
reading speed, are maintained allowing you to work on Macintosh to 
Macintosh without having to reset options. (Kurzweil 3000 Macintosh 
settings are not valid in Kurzweil 3000 Windows systems and vice versa.)
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Kurzweil 3000 Web License Overview
How Does Web License Work? 

Once your organization completes the Web License product purchase 
process, an IT specialist installs the Web License Client Software, and an 
initial user account is set up by Cambium Learning Customer Service for a 
designated License Coordinator. 

That initial user, who could be a school administrator, IT specialist, even a 
teacher, then creates sub-user accounts for sub-site coordinators at different 
schools, teachers and/or students. At the time of user setup, the system 
generates login information — a username and password — for each user. 

Each user, other than Student users, can set up and manage sub-users 
under his/her account.

To access Kurzweil 3000, log in using the Kurzweil 3000 desktop icon on a 
computer running Web License Client software.
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Web License System Requirements 
Web License System Requirements
Minimum G3 processor, running Mac OS X 10.4 (Tiger) to 10.6 (Snow 
Leopard).

Minimum 128 MB RAM (512MB RAM for Cepstral voices).

Minimum 300 MB of hard disk space (500 MB for Cepstral voices).

DVD drive, keyboard, mouse, speakers, microphone, Internet connection for 
Read the Web functionality.

TWAIN- or Image Capture-compatible scanner.

Internet connection required for product use.
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Installing Web License Client Software
Installing Web License Client Software
To install Web License client software:

1. Place the Kurzweil 3000 DVD into the DVD drive.

2. From the DVD window, drag the Kurzweil 3000 application icon to your 
Applications folder.

3. Start Kurzweil 3000 by double-clicking the Kurzweil 3000 icon.

You are ready to log in to and use Web License Edition by clicking the 
Kurzweil 3000 icon.
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Working with User Accounts and License Allocation 
Working with User Accounts and License 
Allocation

After your organization purchases a number of Web Licenses, Cambium 
Learning Customer Service sets up the initial user (typically, this is a 
designated site coordinator who could be teacher, school administrator or IT 
specialist). He/she is given username and password for login.

The site coordinator/initial user can then set up the site users, providing them 
with their system-generated usernames and passwords, and allocating 
licenses.

Once that is done, any user can log in, set up, manage and distribute 
licenses to sub-users under their accounts.

Sub-users are typically teachers who set up their own sub-users, typically 
students.

Student users, however, do not have User Management access.

Accessing the User Management System:

Go to https://accounts.firefly.kurzweiledu.com and log in.

Note: From Kurzweil 3000, you can access your firefly account by choosing 
My Account from the Kurzweil 3000 menu. If you need frequent access to 
this link, consider using View > Customize Toolbars to place the My Account 
button on a toolbar.
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Working with User Accounts and License Allocation
The Home page opens displaying site account information such as the 
number of licenses purchased, allocated and activated.

Along the top, right-hand area are four tabs: Order History, Profile, Users 
and Home. Log Out is in the upper-right-hand corner of the firefly window.To 
create a user:

Registering Users

There are two ways to register sub-users under your account:

• You can register each user yourself

• Or set up self-registration so users may self-register
8



Working with User Accounts and License Allocation 
To register a user:

1. Click Users to open the main Users page. Note that you also can open 
this page by clicking Register and View Allocated Users.

2. Enter the requested user information. If the user is a student, click the Is 
Student box. Then click Add New.

The user information then appears in the Allocated Users list, along with the 
system-generated username and password. Provide users with their login 
information.
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Working with User Accounts and License Allocation
To set up for users to self-register:

If you have the proper permissions, you may set up self-registration for your 
sub-users.

1. Click the Users tab (in the top, right-hand corner of the firefly window) to 
open the main Users page.

2. Click User Self-Registration to open the User Self-Registration page.

3. Enter the Number of Licenses for Registration that you want to allot 
for your sub-users.
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Working with User Accounts and License Allocation 
4. Click Update.

5. Copy the unique product link and distribute it to your sub-users. This is 
the Internet address that your sub-users can use for self-registration.

To self-register:

1. Obtain the unique product link from your organization’s license 
coordinator.

2. Paste that link into a Web browser to open the User Self-Registration 
page.

3. Enter your user information.

4. Click Add New.
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Working with User Accounts and License Allocation
Viewing and Managing Licenses

To view license information:

1. Click Users to open the main Users page. Note that you also can open 
this page by clicking Register and View Allocated Users.

2. In the Allocated Users area, you can find:

• Total Licenses: the total number of licenses for your site.

• Allocated Licenses: the number of licenses distributed among users.

• Activated Licenses: the number of licenses in use.

• Remaining Licenses: the number of licenses remaining; that is the Total 
Licenses minus the Allocated Licenses.

3. In the list, you can find each user’s limit of licenses allotted, how many of 
those licenses are actively being used by teachers and students.
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Working with User Accounts and License Allocation 
To set the default number of licenses to allocate to new users:

This is the default number of licenses you want to allocate to each of the sub-
users you add.

1. Click the Users tab to open the main Users page.

2. Click User Self-Registration to open the User Self-Registration page.

3. Enter the Number of Licenses for Registration that you want to allot 
for your sub-users.

4. Click Update.
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Working with User Accounts and License Allocation
All new users added subsequent to this update will be allocated the newly set 
number of licenses.

To change license limit for an individual user:

1. Click the Users tab to open the main Users page.
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Working with User Accounts and License Allocation 
2. Click the desired name in the Allocated Users list to open the User 
Information dialog.

3. Change the number in the Teacher Limit box.

4. Click Update Member Information.

Teacher Limit
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Working with User Accounts and License Allocation
Managing Users

To delete a user:

1. Click Users to open the main Users page. Note that you also can open 
this page by clicking Register and View Allocated Users.

2. In the Allocated Users list in the main Users page, select the desired 
name, click the Delete X in its row.

Note: You can use the Manage Removed Users page to view and manage 
deleted users’ information.

To restore deleted users:

1. Click the Users tab to open the main Users page.

2. Click Manage Removed Users.

3. From the Manage Removed Users page, you can restore a user from 
the list by clicking the Restore icon for that user.
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Working with User Accounts and License Allocation 
To change user information, including password:

1. 1. Click the Users tab to open the main Users page.

2. Click the desired name in the Allocated Users list.

Click to open User Information dialog.
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Working with User Accounts and License Allocation
3. In the User Information dialog that opens, make the desired changes.

4. Then click Update Member Information.
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Working with User Accounts and License Allocation 
Viewing and Changing Your Personal User Information and 
Password

To view and change your own user information, including password:

1. Do one of the following:

From www.fireflybykurzweiledu.com Home page, click My Account, 
then click Profile.

Or, from www.accounts.fireflybykurzweil.com, click Profile. 
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Working with User Accounts and License Allocation
The Profile page includes user information such as address and 
occupation, login, and school/organization information.

2. Make the desired changes.

3. Then click Update Account Information.

Forgot Password?

1. Click the Forgot Password in the log in page.

2. In the Forgot Password? page, enter the email address associated with 
your account.

3. Your username and the original password will be emailed to you.

4. Use the emailed password to log in.

5. Go to and follow the instructions in To view and change your own user 
information above.
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Working with User Accounts and License Allocation 
Viewing Order History 

Users (other than students) can check Order History to find details about the 
organization’s licenses, such as, Order Dates, products, licenses and their 
activation/expiration dates. 

To view the Receipt for an order, click the desired order number in the Order 
Number column.

To view the Invoice for an order, click the desired Invoice number in the 
Invoice column.
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Working with User Accounts and License Allocation
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2 Web Universal 
Library 

This chapter contains four main sections.

• The Web Universal Library Overview on page 24 has the following 
subsections:

Web Universal Library Structure on page 24.

• Using the Web Universal Library on page 26 has the following 
subsections:

To open a document from the Library: on page 26.

To save an open document to the Library: on page 27..

To create a new folder in the Universal Library: on page 27.

To rename a file or folder in the Universal Library: on page 27.

To delete a file or directory in the Universal Library: on page 28.

To cut or copy, and paste a file or folder in the Universal Library on 
page 28.
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The Web Universal Library Overview
The Web Universal Library Overview
Kurzweil 3000 Web License Edition includes the Web Universal Library. If 
your school uses the Kurzweil 3000 Local Area Network (LAN) Universal 
Library, you are already aware of the benefits of central file storage and 
sharing.

The Kurzweil 3000 Web Universal Library, however, is an expanded version 
of the LAN Universal Library. Because the Web Universal Library is Internet-
based, it allows students and teachers, or any authorized users, using any 
computer running Web License Client software from anywhere on the World 
Wide Web, to access and share files.

For districts and schools, the Web Universal Library is ideal for placing 
standardized curriculum material and print resources in electronic form for all 
or for specific groups to access. Teachers can make class files available 
wherever, whenever students need them.

Included in each Web Universal Library are the following folders: 

• Classic Literature, a collection of nearly 2000 books, historical 
documents selected from the public domain

• Samples, files from Cambium Learning Group's published educational 
series, LANGUAGE!, Learning A-Z and Passport Reading Journeys.

Web Universal Library Structure

The structure of the Universal Library is based on user/sub-user file system 
concept where each authorized user can set up and manage his/her sub-
users.

In addition to sub-user folders, each user also has a Public folder and a 
Private folder. All users have Read-Write permission to his/her own and to 
sub-users’ Public and Private folders

Sub-users only have Read access to the Public folder of the user who 
created their account.

For example, a district could set up folders for each school. In a school's 
folder, there could be folders for teachers as well as a Public and a Private 
24



Chapter 2. Web Universal Library
folder. All teachers and students in the school could access the school’s 
Public folder. Teachers would not be able to access one another’s folders. 

Each teacher folder in turn would have the teacher’s students' folders, plus a 
Public and Private folder. All students whose accounts a teacher creates 
would be able to access their teacher’s Public folder. Students would not be 
able to access one another’s folders.
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Using the Web Universal Library
Using the Web Universal Library
You can open and save to the Universal Library and manage folders and files 
by using either the Open from the Universal Library or Save to the Universal 
Library.

The Web Universal Library currently supports RTF, TXT and KES file 
formats.

To open a document from the Library:

1. From the File menu, choose Open from Library to open the Universal 
Library.

2. Navigate to the desired folder and file, then click Open.

3. Use the Kurzweil 3000 Reader to read the file.
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Chapter 2. Web Universal Library
To save an open document to the Library:

1. Open the document you want to save to the library.

2. From the File menu, choose Save to Universal Library.

3. In the dialog, specify where you want to place the file by clicking the 
desired folder in the left-hand pane.

4. Click Save.

Notes: 

• When saving a file, you are uploading it to the Web server, and the time 
and speed by which a file is uploaded depend on the Internet line and 
service at your site. We recommend 50 pages or fewer per file, so it's a 
good idea to separate chapters and save a chapter at a time.

• You can only save to the directories for which you have access 
privileges.

• No user can save files to the Classic Literature folder.

To create a new folder in the Universal Library:

You can create a new folder in the following places:

• Under your own user directory, in the Private and Public folders.

• In the Public folders of directories belonging to sub-users whose 
accounts you created.

1. From the File menu, choose Save to Universal Library.

2. In the dialog, in the left-hand pane, select the directory under which you 
want to create the new folder.

3. Click the New Folder button.

4. Rename the folder.

To rename a file or folder in the Universal Library:

1. Select the file or folder.

2. Click again or press Return to begin editing.

3. Type the new name, then press Return.
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Using the Web Universal Library
To delete a file or directory in the Universal Library:

1. From the File menu, choose either Open from or Save to Universal 
Library.

2. In the dialog, do one of the following: 

In the left-hand pane, select the directory you want to delete.

In the right-hand pane, select the file you want to delete.

3. Do one of the following:

Control-click and in the context menu, choose Delete.

Use the Forward-Delete or Backward-Delete shortcuts.

Notes: 

• If you use the Delete command in the Save to Universal Library dialog, 
you have to click Save to close the dialog when you are done.

• You can only delete from the directories for which you have access 
privileges.

• No user can delete files from the Classic Literature folder.

To cut or copy, and paste a file or folder in the Universal Library

1. From the File menu, choose Open from Universal Library.

2. In the dialog, do the following: 

In the left-hand pane, navigate to and select the folder you want to cut or 
copy, or the folder that contains the file you want to cut or copy. You can 
only cut or copy folders that are inside your public or private folder. 

In the right-hand pane, select the file you want to cut or copy.

3. Control-click to show the context menu, choose Cut or Copy.

4. Do one of the following:

To paste a file into another folder in the Universal Library, navigate to the 
desired folder in the left-hand pane, click in the right-hand pane, control-
click to show the context menu, and then choose Paste.
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Chapter 2. Web Universal Library
To paste a folder into another folder in the Universal Library, navigate to 
the desired folder in the left-hand pane, control-click to show the context 
menu, and then choose Paste.

To paste a file or folder elsewhere on your desktop or system, navigate 
to that location, control-click to show the context menu, and then choose 
Paste.

Notes: 

• Note that you can only paste if you have Copy To privileges.

• It is possible to Copy-Paste files and folders from the Universal Library to 
the Finder, and files (not folders) from the Finder to the Universal Library.

• No user can cut files from or paste files into the Classic Literature folder.
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Using the Web Universal Library
30


	1 Web License Overview, Set Up and Management
	Kurzweil 3000 Web License Overview
	Web License System Requirements
	Installing Web License Client Software
	Working with User Accounts and License Allocation
	Accessing the User Management System:
	Registering Users
	Viewing and Managing Licenses
	Managing Users
	Viewing and Changing Your Personal User Information and Password
	Viewing Order History


	2 Web Universal Library
	The Web Universal Library Overview
	Web Universal Library Structure

	Using the Web Universal Library


